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new project

oY > ME2ED| > ME2 Z=Z2HE > Visual C/C++ Project > Console Application
File > New >New Project > Visual C/C++ project > Console Application
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Exit
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New Project

Project types: Templates:

Win32 Consol Application=2

= Visual Basic
Windows
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Win32
PGl Visual Fortran
- Other Project Types
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 Visual Studio installed templates

EWinSZ Froject

Search Online Templates. .,

i

|4 praject far creating a Win32 console application

Mame: | <Enter_name>

Location: |C:WMPI

S (B

FOWwsSe, ..

| [ Create directory for solution

I

Cancel

NextE =2 Z2HMEN e Sd= NI = UL

Win32 Application Wizard - test]

Welcome to the Win32 Application Wizard

Overview These are the current project settings:

application Settings ® Console application

Click Finish from any window to accept the current settings,

After wou create the project, see the project's readme. bk file For information
about the project features and files that are generated,

[ Mext = |[ Finish ][ Cancel ]

Console applicationt Empty projectE & €8
i 0fl= Windows application2 & EigtH &
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Win32 Application Wizard - testl

Application Settings

Overview Application type: Add common header files For:
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File  Edit
& - i

View Project Build Debug  Tools  Window  Community  Help

9 .- B2 |y Debug - Win32 - [
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& | [] Solution testl’ (1 projact)
m| 2 A test]

2 4 Header Files

z [ Resource Filas
%
=
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# Cut Existing ltem...
3 Copy 4 Mew Filter
b g Class.,.

W Remove v Hesourca,,,

Rename
Properties

Error List -1 X
@ 0Errors| 1\ 0Warnings | (i) 0 Messages
Description File Line Column Project

c Salution Explorer]@C\ass Wiew |5 Error List]@ Output

Creating project ‘testl’, . project creation successful,
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AA6tD A2 e EHXE filename.c WEE, C+HHEZ ZZ2 Y ot 42 MHl= filename.cpp2
NEoll== A0l HZIGICH SEXNE LEBHA 22H ANsS22 .cpplt SHECH

Add New ltem - test]

Categories: Templates:

= ViSLLll?l Cs Visual Studio installed templates

-Code .m [ Header File (.h)

Data =) Midl File 1 ﬁMndule—Definitinn File { def
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ieb &) Comp &

-Utility
" Property Sheets My Templates

1 Search Online Templates...

|Creates a file containing C++ source code |

Marne: |<Enter_name> |

Location: [ #MPlest] | [ Browse.. |
[ Add ][ Cancel |
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29 testl - Microsoft Yisual Studio
File Edit Miew Project Build

Debug  Tools MWindow Community  Help
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B b oax | F =2 |0&3 6850
@ Solution Explorer - Soluti,,, « & X /igst_cpp,] - X
ok & | [ |(Glubal Scope) v|| v
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Error List *» 0 x
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Description File Line Column Project
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compile
Build M2l Build 282 Soll 202 A SHSHCE.

9 testb4 — Microsoft Visual Studio
File Edit Mew Project | Build | Debug Tools MWindow Community  Help
é-n TR N- Y Build Solution Ctrl+5hift+B a9 - | % i

1 S b A Hebuild Solution
O ol Fey A= : |
B Solution Exp\orer - Soluti,, Clean Solution —
ol B | Euild testhd v|| “prnain(} v
& ; Solutlon ‘testhd’ {1 pr Fiebuild testsd F f
m | = 23 testhd k!
‘g 3 Header Files Cle:e)n (e
] 1 Resource Files Froject Only 3
e = & ESDL”CE Files @ Extract Compag Visual Fortran Project ltems eger variable. y
] a.c
g Profila Guided Optimization » L
T )
=} f uted, Then the i == 10
= Batch Build... luated. If TRUE the block
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& Compile Ctrl+F7
- T
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Show output from: Build - _; ;Jjj, =>4 =]

Clean started: Project: testbd, Configuration: Debug Win32 --——-
ng intermediate and output files for project "test%4 ", configuration “Debugi®in3z
== [lean: 1 succeeded, 0 failed, 0 skipped s=========

ngSolution Explorar @Class Wiew _-aError List| 5] Output
Clean succeeded Ln 4 Col 1 Ch1 INS
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esthd - Microsoft Visual Studio
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Output -
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r:fgSqution Explorer @CIass Wiew jsError List =] Output
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File Edit Mew Project Build Debug Tools Window Community  Help
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] Solution Explorer - Soluti,, - & % Start Page “a.c - ¥
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m| = 5 testhd s#include <stdio.hs )
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pi = ng?u;cce Files J int i=1: /+ Define an integer variable. +/
3 .
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g + The block is executed. Then the i <= 10

+ expression is evaluated, |f TRUE the block
+ 5 executed again,

+f
do
{
9 printf ("0 is Zifn", L
i++) 9
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Output > & X I
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12——-— Build started: Project: test54, Configuration: Debug Wind2 --———-
1=Campiling. ..
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1=Embedding manifest...

1=Build log was saved at "file /o WP It ect SH0ebugBLi (dLog, htw”

I1=test54 - 0 error(s), 0 warnina{s)

========== BJj|d. | gucceeded, O failed, 0 up-to-date, 0 skipped ==========

f:fgSolution Explarer 'Q'gCIaSS e _-aError List| =] Output
Build succeeded Ln 10 Cal 1 Chi M5




Debugl =2l Start Debuggings AEHGIHLE F5IIE =2 CIHA

flo
>
yd
o
Q

a2 testbd - Microsoft Yisual Studio __ E|&|
File Edit “ew Project Build | Debug | Tools  Window Comrmunity  Help
- 3- 65 3 @ | % Gam | Windows L - | [ M
3 S, b as | 5 = -|  Start Debugging F5
B Solution Explorer - Soluti,, - & 3P Start Without Debugging Ctrl+F5 - X
w0 & | [F |5k Attach to Process,,, v| e main() 7
& || [5] Solution testsd’ (1 project) Exceptions,., Cirl+dlt+E | TI
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‘g [ Header Files | oEp kB il
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= &9 Delete &l Breakpoints  Ctrl+Ghift«F9  [ecuted. Then the i <= 10
valuated, |f TRUE the block
) Disable Al Breakpoints in.
do
{
[~ printf i is Zi#n", in
i++; b
< | >
oo x|
show output from:  Build LB L& s | = | 5]
J3———— Build started: Project: test®4, Configuration: Debug Win32 -——-——
1=Compiling. ..
1=a.c
1=Compiling manifest to resources. ..
1=Linking. ..

1=Embedding manifest...

1=Build Iog was saved at “file!//ciiMP I#test S40ebugiBui Idlog. him”

1=testhd - 0 error(s), 0 warningls)

========== BUj|d! 1 succeeded, O failed, 0 up-to-date, O skipped =s=========

L}QSDIutinn Explorer @Class LT _-BEerr List| 5 Qutput
Build succeeded Ln 10 Col 1 Ch1 NS
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File Edit Miew Project Buoild Debug Tonls  Window Community  Help
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= | @ | 5
—| [5 Solution ‘testsd’ (1 project
g#include <stdio, n= 25 testsd I
[ Header Files
Eﬂﬁln( i [3 Resource Filas
o int i=1: A+ Define an integer variable. */ o “"E?L:CCE Files
* u
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# i =
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+
+f
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File Edit View Project Build Debug Tools  Window Community  Help
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—I| 5] Salution ‘testsd (1 projed
s#include <stdio,h> ~| = 7 testhd
. 3 Header Files
?a'”( ! 1 Resource Files
() int i=1: /+ Define an integer variable. */ = ‘JE‘DL‘;CCE Files
i
+ The block is executed. Then the | == 10
+ expression is evaluated, |f TRUE the block
+ i5 executed asain,
*/
do
{
] printf {70 is Iitn®, X
i++)
}owhile {i <= 1000%
v
< > < ¥
Autos
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Ji -355993460 int
;:jAutos (-.;jLocaIS aWatch 1 Q'JCaII Stack _jBreakpuints 57 Comman... !jlmmediat‘.. =] Cutput
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Next HEZS 2™, & ZD}F printfI A 8= T 10, igt0l 12 HIHAUASE 2 = UL
22 testhd (Debugging) - Microsoft Yisual Studio

File Edit ¥iew Project Build Debug Tools  Window Comrmunity  Help

IR A= W= N TRECTF - A R = ) 2
P @ @ | 5= [= 2= Hex fﬁviﬂi%@,m iE iS N N = e P = =
m » % | Solution Explorer ... = 3
|(Glnhal Scope) v |[ -emain() v &
[d Solution ‘testhd’ {1 projer
s#inciude <stdio.h> “ | = Fltestod
_ - [ Header Files
faing ) - [ Resource Files
o . . : = [ Source Files
9 int i=1. f+ Define an integer variable, +f - & Bl
Fx
* The block is executed. Then the i <= 10 -
* expression is evaluated., If TRUE the block
* |5 executed again.
+/f
do
@ printf ("i is Zitn", ik
i ++;
Powhile Ci <= 1000);
¥
< | > < | >
Autos R Commmand Window
| Name | Walue | Type
@i 1 int
&) Autos |Z] Locals | 5] Watch 1 @ Call Stack | Breakpoints | ;] Comman.,.. |Egimmediat.. |5 Output
Ready Ln 15 Caol1 Ch1 NS
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TSt 0IRA QEEIIE F=2H YT Breakpoint S8 &A8E 4= QUL

#2 testhd (Debugging) - Microsoft Yisual Studio

File Edit “iew Project Build Debug Tools Window Comrmunity  Help
EIRNEERA=N " I N =R TR SRS (% 2
P @@ >CE[E Hex B A Rbhoa | EEZ2 OLG 0B85 0.
ﬁm -~ ¥ | Solution Explorer,,, « 3 X
|(Glnhal Scope) v|| rnaint) v| 2 | [=
—1| [5] Solution ‘testsd’ (1 projec
g#include =stdio.h= * = 5] testhd
. 3 Header Files
maind ) [J Resource Files
(] inti=1 + Nafina an integer variable. +/ = I_jf“nurce Files
Call Browser » GLE
-8 Go To Definition ecuted, Then the | <= 10 L
+= Go Ta Declaration valuated, If TRUE the block
3 = in.
Find &ll References
d
{D Go To Header File
° T| Breakpoint » || Delete Breakpoint |
Powley sdd Watch |J Disable Breakpaint v
< &d QuickWatch, ., Locatian,.. | J 2 ||« |
&utos Condition, ., [x Command Window -« 1 X
Name. o Show Mest Staternent Hit Count, . L zhelp
Wi
= Fun To Cursor Filter, .
% Set Mext Statement When Hit,
#3 Go To Disassembly
& Cut
B3 Copy
] Autos & 1= I r&‘jCaII Stack |G Breakpoints |; Comman,,, |glmmediat,., |5 Output
Fieady Outlining 4 Ln & Col B Ch 6 NS
Old8t Jl=s= 0I=280ot( st= &tE Y= AAotH HagtsS IHYotd g ZEAExE e 2AHGIH LE
2 QIC}
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C/C++ OpenMP programming with Visual Studio 2005

OpenMP environment

OpenMP is attractive parallel programming method. We can easily parallelize our serial codes, but OpenMP is
only for SMP machine. Nowaday, it is easy to find out the PC which have 2 or 4 core CPU. In this machine, we
can learn and test openmp code in windows PC environment. Various compiler support this parallel programing
method. First, | select Visual Studio 2005 to start the journey. We can parallel programming with C/C++ in Visual
Studio 2005. IMHO, Its IDE has many benefit for beginers.

Visual Studio2005= Jl& AI&aH)| M0 WY s8 HBUHCZ HH OpenMP Zz e o= USLICH
HX Visual C/C++ Z2HEE MAMEHLICEH. OlM, B! projectE MAEHLILCEH

Cveryiew Application bype: Add common header Files for:
Application Settings © windows application

(%) Cansole application

() DLL

() Static library

Finish ” Cancel
LAY S oLt -0l DEE YHELILH JI=0H= UGS 25U

#include <stdio.h>
#include <omp.h>

int main (int argc, char *argv[]) {
int nthreads, tid;

omp_set_num_threads(4);
#pragma omp parallel private(nthreads, tid)
{
tid = omp_get_thread_num();
nthreads = omp_get_num_threads();
printf(" Hello World from Thread %d of %d #n", tid, nthreads);
}
return 0;

}

13



2% 0901-b - Microsoft ¥isual Studio

File Edit Mew Project Build Debug Tools Window Community  Help
A-E- S e %G ® - &~ b Debug - Win32 - | o
E & e Az =R ® 5Ll
) Solution Explorer - Soluti,,, » 3 X example,c > X
wl k= | @ [F {Global Scope) R v
§ (o Solution '0901-b" {1 project) B#include <stdio.h= =
m || = 51 0901-b L#include <omp. h= A
= 1 Header Files
E] 3 Resource Files Bint main {int arac, char +argv(]} {
;L 5 B Source Files int nthreads, tid:
C—:q ¢ example.c omp_set _num_threads{4);
el #pragna omp parallel private(nthreads, tid)
(=] {
£3 tid = omp_get_thread_numi };
nthreads = omp_get_num_threads( )
L%ﬁ printf(" Hello World from Thread Zd of %d #n", tid, nthreads);
- }
3 return 0:
& }
=
z g
v
< >
Qutput >~ 0 X
Show output from:  Build - = | =1
_;jSDIution Explorer _}—SC|aSS Wi _:"'}Error List| =] Output
Build succeeded Ln 16 Cal 1 Ch1 INS
Visual Studio 2005= OpenMP C/C++2 J|22 2 XIJAELICH openmp.h & dlIHIH0 <

FoE=ELIh

WINDOWSWsystem3I2Womd. exe

Helle Yorld from thread

Mumber of threads = 1
y H Ot 3Lt
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otXIgt, 23 thread H=+E 4 =,

H=z X
Visual StudioOl Al openMPZ Y S dHIIRIdAM=
/openmp S&S F 0t &LICH
C/C++ > Command Line > Additional Options >

1JHet

0901 -b Property Pages

Configuration: | Active(Debug) w | Platform: | Active(Win32)

All options:

/0d
ARTCT /MDd /]
JerrorBeport:prompt

+- Common Properties
= Configuration Praperties
General
Debuaaing
= CAC++
General
Optirization
Preprocessor
Code Generation
Language
Precompiled Headers
Output Files
Browse Information
Advanced
Cormrmand Line
Linker
Manifest Tool
AML Docurnent Generate
Browse Information
Build Events
Custorn Build Step
ieb Deployment

- [

Additional options:

D WINSZF/D _DEBUG" /D "_COMSOLE”
‘Debughw” /Fd" DebugWtwcd0 pdb”™ A3 /nologo /o /Wphd A2]

[ Configuration Manager, ,,

D "_UMICODE" /D "UMICODE"

/r_lq'j/EHsc

Ol Xl

Hello World from
Hello Yorld from
Hello Yorld from
Hello World from

Thread @ of 4

Thread 1 of 4

Thread 3 of 4

Thread 2 of 4
)

9ot S|l

Mg

>y

mo
J

ror
0
Wx
0
0

s

Ol Ml OpenMPZ I =E2 &t

OlHl OpenMPZ AN H&EZZcH
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3. C/C++ MPI programming with Visual Studio 2005

MPI(Message Passing Interface)= Cluster Computer =, 020l FEHE HEEZ HZE AIAEUA

g o2 =s =2l fIst &H0ICH OpenMPIt A H =EWHM XJAdt=RD C2H MPle 28XA =
OS =Z0lA XI&AdHOF StCE. Linux2 UnixBM= CH2SHA MPIEtEE 2 = U=0, Windows &332 3N
3N E UHE &= UL

1. Windows 2003 AMHXIZ 0l Cluster Comute Pack(CCP)E & XI5t HLE Windows 2003 CCPE A Xlol=
B OICH OSXHR0IA =& XIKot)| 20 H2IoHKICH 2 =Y glo|MAZE 2H0t0F 61D 20l HI=&Ql

=}

HolM 2 2801 =L

2. Windows0ll Cygwing &XIot] WindowsE MPIS! LAMZ2 &XIotH AFEE = QUCH cygwine AHalC

AFEO LinuxatZ S &XIdct= A0 HI=x5HI| [[H+O1I CHSE Linux SSEZ2 032 ME2EE = U
2Z0ICH MSTote =2XNUAH 22 He S0l A2 = UKL, 220= X2 AFE0| R

A AIESE = UL

3 WlndowsOﬂ WindowsZ MPICH2E &XIct= ZEOICH HIE% 11, JIHE &H AMEF &= A1, Cygwin2

2 Vlsual studlo Intel Fortran Compiler& Ct&st 8232 X8 2 20 ME Windowsl MPICH2E
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2. Select Visual C++ project Windwos application & empty proejct

o > MZ0tED| > 28 Z2HE > Visual C/C++ Project > Console Application
File > New >New Project > Visual C/C++ project > Console Application

Bl TZNEE OsLIC

Win32 Application Yizard - 0901-a

: Application Settings

Ceryis Application type: Add comman header files far:
Application Settings © windows application

() Console application

Ol

() Static library

Additional opkions;
-

[ Finish ” Cancel ]

= IZ2HE SMI|NMADD New item=
o C++2 MAANCHH filename.cpp, C2
AMNSELICH CHIAMS AISEgS 20 52

o Code > C++ File 2 M8 AADEME S GHLE EHSLICH
A ]

Categories: Templates: |§|
= ViSUU?| C++ Visual Studio installed templates
Code [ C++ Fils {.cpp) (] Header File {.h)
Data L Midl File Cidly #z]Module-Definition File (,def)
Resource Component Class Installer Class
iifeh ] Lomp &
[Hility
Property Sheets My Templates

|4 Search Online Templates, .,

|Creates a file containing C++ source code |

Mame: [mpi,c

Location: |cPI0301 -2

|
| [ Browse.. |

( Add | [ Cancel |
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OlMl, MZ222 E0l A2ADEE LSELICH MEE DE= USH ZSLILCH OE2 MPI Z20H2o JIXE
BHSX &EpAJ 201, S201 g=otl), BWeEdts A Agol = ALICH =2/ X2 C language=
HAEXE Jteldl 20 =23HH0E 8 LICH £31, MPI S8 0= MPI_Axxxx_xxxx() & SEHE 01D USLICH
=, A 4K HEX0lD UHX=E 25 A2XLICH

#include <stdio.h>

#include "mpi.h"

int main(int argc, char *argv[]) {
int rank, size;

MPI1_Init(&argc, &argv);

MP1_Comm_rank(MP|_COMM_WORLD,&rank) ;
MPI_Comm_size(MP1_COMM_WORLD,&size) ;

printf("Hello, world | am %d rd core of %d core systemfn", rank,size);
MPI_Finalize();

return 0;

=)
L:_I
e
o
oy
L:_I
ne
%
It
-
[w

Check Compile !!

You find Error Message!!. We need to register mpi.h library
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include files

T2 > 38 > I2HME > \Visual C++ L EZ| > FIt It

Tools > Options... Menu > Proejcts and Solutions > Visual C++ Directories > Include files
C:WProgram FilesWMPICH2Winclude

Options
®- Enviranment Platform: Show directaries for:
= Projects and Solutions | Win3z v| rciude fes
General ;
. Build and Run :
B Defaults *"] ﬁ‘l X] *I *I

WC++ Directories %EEEInStaIIBirginFHdﬁv' i

i i nstallDirjatimfcinclude
ST IS RRnge $(VCInstallDin)PlatformS0KWinclude
Teet Editor $tFrameworkS0KDirinclude

Database Tools
Debugging

Device Tools

HTML Designer

Windows Forms Designer

=3

|

E-El

< | >

Include Directories
Path to use when searching for include files WhI|E building a WC++ project,
Corresponds to environment variable [MC

( oK |[ Cancel |

Library Files

S > 38 > T2HE > \Visual C++ CIEEZ] > 20|22l I
Tools > Options... Menu > Proejcts and Solutions > Visual C++ Directories > Library Files
C:WProgram FilesWMPICH2Wlib

Options
& Environment Platform: Show directaries for:
= Projects and Solutions | Win32 w| |Library files
General ;
. Build and Run
Y& Defaults o "I.XI"I"‘J
W+t Dirqctnries | [ 1
& SD,_,\:EEJrEErnDtJrEFt Setings $(VCInstaIIDlr)atImchhh ;
& Text Edit Y CInstallDir jatirmfc b 306
B L EDNL $0%ClnstalDiriPlatforrmSDKib
i Database Tools $iFrameworkSOKDInlit
- Debugging $ S InstallDiry
- Device Tools $VSInstallDinlib
#- HTML Designer
& Windows Forms Designer I
¢ | >

Library Directories
Path to use when searching far library files while building a YC++ project,
Corresponds to environment variable LIB,

( 0K ][ Cancel |

Check Compile. not yet success!!
We need to configuration of project property
Click proejct name and Right Click & select Property.

=2l
=

1]
[F

2HE 0|5 > 0I9A Q2% 22 > #ALH
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0901 -a Property Pages

Configuration: |Active(Dehug) V| Platform: |Active(Win32) V| ’ Configuration Manager, ., ]
Common Properties = General
=- Configuration Properties Output Directony $SolutionDir$ ConfigurationMame) v
g:;ﬁ;ging Intermediate Directary $iConfigurationfama)
C/C+ Extensions to Delete on Clean = objixilki= b= i+ Hhi= tmpi= rspi+ paci= pad:$ Tar
Linker Build Log File $CIntDinWEuildLog, htm
Manifest Tool Inherited Project Property Sheets
#ML Documnent Generatd |5 project Defaults
LoilvdstewIannftoSrmatmn Configuration Type Application (.exula) o
Custorn Build Step Use of MFC lUse Standard Windows Libraries
Web Deployment Use of ATL Mot Using ATL
tinimize CRT Use in ATL Mo
Character Set Uge Unicode Character Set
Comrmaon Language Runtime support Mo Common Language Runtime support
Whole Prograrm Optimization Mo Whole Program Optimization

Qutput Directory
Specifies a relative path to the output file directory can include environment variables,

St=2 Visual Studio 2005 : &H > & > FIE=4

AZ Visual Studio 2005 : Linker > Input > Additional Dependencies

Ol mpi.lib, cxx.lib € FII&tCh 0] IS MPICH2 2 libraryI} 0| Ch.
Sct0lEecle s 20

mpi.lib C Language&
cxx.lib C++&
fmpich2.lib Fortran& OIC}.

(letA, mpi.llib cxx.lib SIHE FIFAIZILCH.

Additional Dependencies

mpi.lib
cxx.lib

Inherited values:

kermnel32 lib ”~
userd? lib =
gdi32 lib -
winspoal, lib
comdlg3z lib

W

Inhetit from parent or project defaults

Ok H Cancel ]
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Ol &ZB&EE0| 22 ASLICH

Check compile!! ..  We Succeeded !!.
2% 0901-a - Microsoft Visual Studio

File Edit Miew Project Build Debug Tools Window Community Help
RN A=A N~ Ea b Debug ~ Win32 AN ] -
it I =i 103 853
i Solution Explorer - Soluti,,, » & X example.c - X
S e | [ (Global Scope) ~ || =@mainlint argc. char =[] arav) v
§ (o Solution ‘0901-a’ {1 project) E#include =stdio.h= =
mi e =4 0901-a L#include "mpi.h" A
= 3 Header Files B int main{int argc, char +argv[]} {
z 1 Resource Files int rank, size:
| E —-‘E?”me F"?S MPI_Init{&arge, Bargy);
= 24 ewarnple. o HP | _Comm_rank( MP | _COMH_WORLD, &rank );
=3 MP | _Comm_5ize( HP | _COMM_WORLD, &size )
g printf{"Hello, world | am Zd rd core of Zd core systemfin”,rank,sized
= MPI_Finalizel);
return 0;
Ligy ]
o
=]
=
o
=
o
oy
v
< ¥
ouput . .. -1X]
Show output from: Build - =
Trmm—— Build started: Project: 0901-a, Configuration: Debug Win32 ---——-
1=Compiling. ..
T=gxanple.c
1=Compi | ing manifest to resources. ..
t=Linking. ..
1=Enbedding manifest...
1=Build log was saved at "file://ci4MPI#0901-atDebugthBuildlog. htn”
1=0901-a - 0 error(s), 0 warningls)
Build: 1 succeeded, O failed, 0 up-to—date, O skippe
._;;lSqution Explorer Z;CIass Wiew _:')Error List| =] Output
Build succeeded Ln 10 Col 1 Ch1 INS

Run without Debug

WWINDOWSWsystem32Womd. exe
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cmd EH= Soll DOS prompt & JF S &'
0901-a.exe ILIL0| M2l A2 &ols = JASLICH

20878782 L= -

2087-09-682 : .-

2087-09-682 48,760 B?01-a.exe

2087-09-82 =1 4@3 A?01-a.exe.embed._manifest
2087-07-82 d 468 B?01-a.exe.embed.manifest.res

2087-07-82 = 385 BA?P1l-a.exe.intermediate _manifest
2087-07-82 318.788 A?81-a.ilk
2087-09-682 : 297.984 B7891—a.pdh
2087-09-62 §.914 BuildLog.htm
2087-07-82 : 4,471 example.ohj
2087-09-682 62 mt.dep
2087-09-82 : 27.648 vucBB_idh
20R7-A9-82 ST = £3.248 vcBB._pdh

i I 745,463 HO

21.704.200,192 HIO|E H2

C:UMPIWA? 81 —alDebug >

Run MPI

mpiexec -n N AHINIL0IE HHEZ2 Soll A &HolH ZUE 0I5 =2 = USLICH

REE
2087-89-82 H 385 B9B1-a.exe.intermediate .manifest I’
2087-07-82 H 318.988 A%P1-a.ilk
2087-09-82 H 297.984 8%01-a.pdh
2087-07-82 H 8,914 BuildLog.htm
2087-09-02 H example .ohj
2087-07-82 H nt .dep
2087-09-02 H vcBB.idh
20A7-09-82
745.463 HIO|E
21,704,.200,192 HfOD

C-HMPIWA?81 —atiDebug mpiexec —n 1 B9@1-a
Hello. world I am B »d core of 1 core system

C=WMPIYA?61—-aWDebug>mpiexec —n 2 B981-a
Hello, world I am 1 »d core of 2 core system
Hello. world I am B »d core of 2 core system

C=WMPIWA?B81—-aWDebug>mpiexec —n 4 B981-a
Hello, world I am 3 »d core of 4

Hello, world I am @ »d core of 4

Hello, world I am 2 »d core of 4

Hello, world I am 1 »d core of 4 core system

C - WMP I A9 81 —atiDe bug >
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C/C++ Hybrid (OpenMP & MPI) programming with Visual Studio 2005

KHAe 2 EEJF SMP cluster?!
MPI= UIERSZ EAS ot)| R0 SAIE
ot NodeZtOll= MPIZ SA&l2

OpenMP2} MPIS
= etolEgel et

Ho =
O T —

OpenMP2t MPIE

SAIO ALS

Fotor 2ol Z2lJl W20,

otH ot HESE S8 0IS2 %0l
SAAIEGHH 882 =M D=0,
openmp B sS&2 ArE6tH ELICH

hybridc Property Pages |E|F5_?|

Configuration: ‘ Active(Debug)

| Platform: | Active(Win32)

Common Properties

Additional Dependencies

b | Configuration Manager, ,,

mpi.lib,cxx,lib

|.L _\_LEJEHO ZKF _\_LIR/\AOI OIALl[ZI,
= OpenMPZEZ SO0IJHA

010l MPI directorye JHQEIQIQEE, T NE MAHA|

= Configuration Properties lgnare All Default Libraries o
gsgﬁging Ignore Specific Library
C/C++ Module Definition File
(= Linker Add Module to Assembly
General Embed Managed Resource File
: ) Force Symbal References
el Delay Loaded DLLs
Systermn Assembly Link Resource
Optimization
Ermbedded IDL
Advanced

Command Line
Manifest Tool
#ML Docurnent Generate
Browse Information
Build Events
Custom Build Step
Weh Deployment

Additional Dependencies
Specifies additional items to add to the link line (ex: kernel32 lib): configuration specific,

3

hybride Property Pages

Configuration: | Active(Debug) v | Plattorm: | Active(Win32)

V| Configuration Manager,,,

{D _UNICODE" /D "UNICODE" mP/EHsc
pdb” /W3 /nologo /o AWpBd /20 AT

Comrnon Properies

Configuration Properties
General
Debugging

- CAC+H
General
COptirmization
Preprocessar
Code Generation
Language
Precompiled Headers
Cutput Files
Browse Information
Advanced
Comrmand Line

Linker

Manifest Tool

XML Document Generato

Browse Information

Build Events

Customn Build Step

Web Deployment

All options:

/0d /D" W\N32F/D _DEBUG" /D "_COMSOLE’
JRTCT /MDd /Fo"DebugWi” /Fd DebugitvcEl
JerrorReport:prompt

=]

) BB

Additional options:
nrip
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2teHst SEHSl Hybrid ZEE &8 LICH
MPI Ot OpenMP ZEJt ChAl HSEE=E As &elg = UsLICH

File Edit Yiew Project Build Debug Tools Window Community  Help
B g ad s b Debug - Winz2 ) = Je: Py =R
b 0 103 £ 5
) Solution Ezplorer - Solufi,,, » & X Start Page ‘a.c > X
ol 2 [F] {Glabal Scope) w || =gmainfint arge. char =[] argy) v
@ | [ Solution hybride’ (1 project) E#include =stdin.h= =
| = 3 hybride #include <omp.h> L
= 3 Header Files #include "mpi.h"
T 1 Resource Files - i ; Y
= H ] g int main{int argc, char +argy
>§L __:Eﬂource s int rank, size;
o Gl int nthreads, thid;
a
= HPI_Init{&argc, &argvl
= WP | _Comm_rank{MP| _COMM_WORLD, &rank )
MF | _Comm_size{MP| _COMM_WORLD, &size
omp_get_num_threads(4);
#pragma omp parallel private(nthreads, thid}
thid = omp_get_thread_num( };
nthreads = omp_get_num_threads( )
if(thid==0 &&rank==0) printf({"Threads Zd Process Zd is alivetn”,nthreads, size)
printf(" Hello World from Thread #d in &d #n", thid, rankl:
}
MPI_Finalize( )
return 0:
v
4 ¥
Output ~ 4 x|
Show output frorn:  Build - = | =
1e=mm— Build started: Project: hybridc, Configuration: Debug WindZ —-—
1=Compiling. ..
1=a.0
1=Linking. ..
1=Embedding manifest...
1=Build log was saved at "filet//ci$WPI%hvbridcDebustiBuild og. htn”
1=fwbridc - 0 error{s), O warning{s)
S == Build: 1 succeeded, 0 failed, 0 up-to-date, O skipped ==
..-jSqution Explorer _/'“SC\ass Wiew _:‘}Error List| = Output
Build succeeded Ln9 Col 1 Ch1 INS
Inxel SHH ol = S o AL A= A
A HotH ZaaMELICH Ol =g 2 LE28+2 SMP core =5 X&I9 AIAEIN XH &2 E ol

/él o o
| =0 A#DCI} ELIC

WWINDOWSWsystem32Womd. exe

IC:WMPIWhybridcWDebugimpiexec —n 3 hybridc
Hello World from Thread 8 in 1
Hello World from Thread 1 in
Hello World from Thread 3 in
Hello World from Thread 2 in
Threads 4 Process 3 is alive
Hello World from Thread @ in
Helle WYorld from Thread 2 in
Hello World from Thread 1 in
Hello Yorld from Thread 3 in
Hello World from Thread @ in
2
3
i

[

Hello Yorld from Thread in
Hello Yorld from Thread
Hello Yorld from Thread

in
in

NMNNMNEGDS®

G : WHP1 Whybridc¥Debug>
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